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1. General Member and Public Access (without an Account)

Ideas lab is available “READ ONLY” on the web at www.ideas-lab.ca

** The website and all proposal contents are viewable to all members and the public at large
without a login. **

Detailed reports, detailed EDA contact information, and the ability to submit, edit, and vote
on proposals are available to Account Holders only when logged in.’

2. Ideas Lab Accounts:

Username or Email Address

Password

|_I I agree to the Terms of Service

[T Remember Me

Each EDA President will be issued a write-access account login by party HQ / IT to use on
behalf of their respective EDA. These login credentials may be designated (transferred) to
any party member upon the EDA board passing a motion to a approve the delegation, which
should be held by an individual who agrees to the terms of service (which require you to
publicly share both your e-mail and phone number with all 343 Ideas-Lab riding contacts)
and is willing to make the necessary time commitment to properly administer EDA proposals
and interact with other EDA’s. https://ideas-lab.ca/wp-login.php

To re-assign your ldeas-Lab login privileges to another member of your EDA board, you must
pass a motion of your EDA board to delegate the login contact. Please send the meeting
minutes to one of the NCC/NPC directors for your province or
oversightcommittee@conservative.ca If you are the EDA president and you haven’t logged in
yet, your username will be lowercase: firstname lastname (such as rorymctory) and click
“Lost your password?” and a password change email will be sent to your email on file. Please
contact ITsupport if you have any issues logging in: itsupport@conservative.ca



http://www.ideas-lab.ca/
https://ideas-lab.ca/wp-login.php
mailto:oversightcommittee@conservative.ca

The terms of service that must be accepted are:

Terms of Service

| agree to the following Terms of Use;

e | am a member in good standing of the Conservative Party of Canada.

e | am the President of the Electoral District Association (EDA) referenced in the
Registration, or the “Designated Alternate” of the EDA referenced in the Registration as
authorized by adopted motion of the EDA Board of Directors.

e My “User-Name” is my name as it appears on my Conservative Party of Canada
Membership profile, and the email address provided is my current and active email
address.

e To use this site solely for Conservative Party of Canada purposes.

e Not to share my ‘password’ with anyone.

e To post submissions or votes to the site only after the Board of Directors of the Electoral
District Association has passed relevant motions approving any post or vote.

e | am responsible for the content of any and all submissions to the Idea’s Lab made under
my “User Name” and that any submissions deemed inappropriate or invalid may result in
the forfeiture of my Ideas Lab access credentials.

. User Profile / User Index

CONSTITUTION POLICY DOCUMENTS USER PROFILE

The user profile is where you can update contact information, e-mail address, password, bio,
etc. as well as provide a short synopsis of any EDA constitution or policy areas of interest.
You can use the bio area to inform people who your constitution or policy chairs are, if that
is relevant to your EDA.

To locate specific EDA contact information for the purposes of seeking co-sponsorship,
consolidation of similar proposals, suggesting edits, or making comments, use the “User
Index” report on the top navigation bar:

REPORTS ~ USER PROFILE



Any of the content of the columns displayed in this report are searchable and sortable:

& PRINT &y EXPORT

(Q SEARCH TABLE ENTRIES

~ ROLE

Provincial (204)
Manitoba Director - 599-
NPC 8261

10/07/2025 19/07/2025
02:11 PM 03:45 PM

Provincial
Ontario Director -
NPC

Car
Karamaoun

Provincial
Ontario Director -
NPC

Daniel
Eustace

Clicking on the “Riding” link will bring you to detailed user contact information. These links
are also displayed throughout the proposal areas.

4. Key Dates:

On the home page, there is this link: https://ideas-lab.ca/key-dates/

To view key dates, click here

The key dates are:
CONSTITUTION

TIMELINE CRITICAL TASK

1. Thursday July 3, 2025 Ideas Lab Opens / Regional Meetings Commence.
. Monday November 17, 2025 Last day for Regional Meetings / Submission Deadline
. Thursday November 20, 2025 21 Day Voting Period Commences
. Thursday November 27, 2025 Ideas Lab Registration Deadline

. Thursday December 11, 2025 21 Day Voting Period Ends

NCC Prepares Convention Content / Send to Translation and
submit content to Executive Director

. Thursday December 18, 2025

. Thursday January 8, 2026 Distribution (Posting) of Convention Packages

. Thursday January 29, 2026 National Convention
Time sensitive deadlines are 11:59 PM Eastern Time.
DISCLAIMER: Any or all dates referenced in this Timeline may be impacted by external events outside the
control of the Conservative Party of Canada, National Council, and or the NCC and therefore subject to
change at any time.
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POLICY
TIMELINE CRITICAL TASK
A. Thursday July 3, 2025 Ideas Lab Opens / Regional Meetings Commence.

B. Monday November 17, 2025 Last day for Regional Meetings / Submission Deadline
C. Thursday November 20, 2025 21 Day Voting Period Commences

D. Thursday November 27, 2025 Ideas Lab Registration Deadline

E. Thursday December 11, 2025 21 Day Voting Period Ends

F. Thursday December 18, 2025 NPC Prepares Convention Content / Send to Translation
G. Thursday January 8, 2026 Distribution (Posting) of Convention Packages

H. Thursday January 29, 2026 National Convention

Time sensitive deadlines are 11:59 PM Eastern Time.

DISCLAIMER: Any or all dates referenced in this Timeline may be impacted by external events outside the
control of the Conservative Party of Canada, National Council, and or the NPC and therefore subject to
change at any time.

. What is the difference between Constitution and Policy?

CONSTITUTION POLICY DOCUMENTS LOG IN

To view key dates, click here

There are two areas to Ideas Lab- Constitution and Policy.

Constitution- is for proposals to change our Party’s Constitution, found here. This process is
overseen by the National Constitution Committee, a volunteer committee elected by
Electoral District Association (EDA) presidents. The Constitution is the legal document that
governs how the Party is run.

Policy- is for proposals to change our Party’s Policy Declaration, found here. This process is
overseen by the National Policy Committee, a volunteer committee elected by Electoral
District Association (EDA) presidents.

The user index is the same for Policy and Constitution, but they each have a separate
submission index.

The details of the processes for both areas can be found in the rules (in the Key Documents
in the next section). The timeline is the same for both Policy and Constitution.


https://ideas-lab-2025.s3.ca-central-1.amazonaws.com/wp-content/uploads/2025/05/22173049/Constitution.pdf
https://ideas-lab-2025.s3.ca-central-1.amazonaws.com/wp-content/uploads/2025/05/22173028/Policy-Declaration.pdf

For the proposal phase, each EDA may submit/sponsor or co-sponsor up to 5 items on Ideas
Lab for Policy, and up to 10 submissions and 10 co-sponsorships for Constitution.

. Key Documents:

CONSTITUTION POLICY | DOCUMENTS | USER PROFILE

The key documents are found on the documents tab: https://ideas-lab.ca/documents/

The key documents include the links to the party’s official Constitution, the CPC Policy
Declaration, the CPC Policy Rules, Procedures and Guidelines, and the NCC Guidelines for
Constitutional Amendments.

Please read the rules before posting proposals on Ideas Lab.

. How to | navigate on Ideas Lab?

For logged in users, the following actions are available from the main navigation bar:

REPORTS ~ USER PROFILE

HOME CONSTITUTION SUBMISSION INDEX FR LOG OUT &

HOME: Return to main Policy or Constitution landing page

CONSTITUTION/POLICY: Ideas Lab is split into two main areas: Policy and Constitution.
Toggle between these two areas by clicking on “Constitution” or “Policy” in the top
banner. If it says “Constitution” in the top bar, it is a link to the Constitution side of
Ideas Lab, which means you are currently seeing the “Policy” section. If it says “Policy”
in the top bar, it is a link to the “Policy” section of Ideas Lab, which means you are
currently viewing the “Constitution” area.

REPORTS: A dropdown to access available searchable reports


https://ideas-lab.ca/documents/

e DOCUMENTS: Links to the party’s official Constitution, the CPC Policy Declaration and
other relevant Ideas-Lab documentation.

e USER PROFILE: Update contact information, e-mail address, password, bio, etc. as well
as provide a short synopsis of any EDA constitution or policy areas of interest. You can
use the bio area to inform people who your constitution or policy chairs are, if that is
relevant to your EDA.

e EN/FR: Change the language displayed in Ideas Lab.

8. How do | make a submission?

The Policy and Constitution areas of Ideas Lab are each divided into sections, which
correspond with their respective governing document major headings (ie. CPC Policy
Declaration or Constitution).

Last day for Regional Meetings /
Submission Deadline

114 14 38 13

Days Hours Minutes Seconds

Title
A ROLE OF GOVERNMENT

B. GOVERNMENT ACCOUNTABILITY

C. DEMOCRATIC REFORM

Clicking inside of any of these sections will show a list of the existing individual policies or
constitutional articles that fall under these major headings. EDAs may propose to 1) add
new items, 2) modify or 3) delete existing items in each of these Forums.



Any proposal, whether to add a new item or modify an existing item, will appear as a
“Topic”. Proposals to add new items will appear as a Topic directly under the Forum
heading. Proposals to edit an existing numbered item will appear as Topics inside the
numbered item (i.e. ‘drilling down’ one level).

TOPIC EXAMPLE:

In the screenshot below, there is a Topic under heading A) Role of Government titled “Test
Policy Example”.

This indicates a proposal to add a NEW numbered item under heading A) Role of
Government of the CPC Policy declaration. The ability to add other new proposals (Topics)
to this section is the Submit New link:

Return to Home Page

Submit New

Title

1. Role of Govermment

Test Policy Example

. What is included in a submission?

A submission includes:
Title- Give the proposal a descriptive identifying title. Unless this is a new section this title
will not be entered in the Constitution/Policy Declaration.

Content- Enter in the content of the proposal:
Content

Visual | Text

File v Edit+ WView » Insert v Formats Tools » Table «

L

Paragraph v B I U wmc 6 = v
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4
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This policy is a test example, it is underlined and under 50 new words in English (75 in French). The existing poliey is not

underlined, and it should be worded exactly as written in the existing Policy Declaration. Existing text to be deleted must be

crossed out using a strikethroush:




Resolution type- Select one of the following Resolution Types from the dropdown:

Resolution Type

MODIFICATION
DELETION
BUNDLED

NEW: Select for proposing any NEW numbered items under the main heading.

DELETION: Select to indicate the proposal deletes an existing declaration in its entirety.
MODIFICATION: Select to indicate a significant re-write of the language or content of an existing
declaration.

BUNDLED: (for policy only) - a bundled submission can use up to three sponsorship spots of 50
new words each, to allow for longer submissions. When bundled is chosen a new box will show
up which requires you to enter the number of submissions spots to use. This will count against
your 5 total allowed policy spots.

Resolution Type

BUNDLED

Number of submissions and co-sponsorships to use

-

Rationale- enter in the rationale:

Rationale

Visual

Edit v View » Insert v Formaty Tools » Table »

File »
Paragraph + B I U we g = v S v = = = &
Georgia v 12pt vy iE S H O O = A~ H

This is where the rationale should go. The rationales is limited to a maximum of 100 words in English or 150 words in French
(of which any “hyperlink” will be considered 1 word). Images are not allowed to be used within either the rationale or poliey.

EDAs are weleome to use images within the destination of a hyperlink if they so choose.

Translation of your submission and rationale- you are encouraged to provide an initial
translation, and can use a free translator such as Google Translate or DeepL. This is not the
final translation, if your proposal makes it to the convention, it will be professionally

translated:


https://www.deepl.com/en/translator

Translation of Your Submission and Rationale

Visual

File y Edit v+ View s Insert y Formats Tools v Table »

Paragraph v B I U e & = v S+ = = = & 82
B

Georgia v 12pt v <= S EH @ O = A

Cette politique est un exemple de test, elle est soulignée et comporte 50 nouveaux mots en anglais (75 en frangais). La politique
sxistante west pas soulignée et doit &tre formulée exactement comme dans la déclaration de politique existante. Le texte existant

a supprimer doit étre barpéi ) aide d'unebarre:

AARALAR VAR,

Confirm that the proposal meets the requirements:

This proposal has received Board approval and is documented in Board minutes

= Il

New words are underined and deleted words are Straek

= Il

This proposal has a maximum of 50 new words (75 en franc:

=

The rationale has a maximum of 100 words

= Il

The submission and rationale are translated (you can use an online translator)

=

Terms of Service

+ | agree to the Terms of Senvice

Submission Voted on by EDA

v= Il

Submit and upload your minutes (failure to provide minutes may result in disqualification)

When you click on “Submit and upload your minutes” you will be directed to the EDA board
minutes submission page. Once a proposal is submitted it will automatically be given a
submission ID which identifies the submission in the submission index.

10



10. When and what supporting documents are required?

Supporting documentation is the EDA board meeting minutes (from the EDA board as a
whole) that must be submitted with every action (posting a new proposal, cosponsorship
and voting). The National Constitution Committee also requires proof of the notice of the
meeting.

We do not need the full meeting minutes, only the relevant sections. One option is to use
the fillable minutes templates in the documents page of Ideas Lab. https://ideas-
lab.ca/documents/

11. How do | include supporting documentation?

Once you submit a proposal, cosponsorship or vote, you will be taken to the page to submit
minutes. Once the minutes are submitted, they go to the Oversight Committee for review. A
member of the Oversight Committee will contact you if there is anything further needed.

Riding 10001 - Avalon
Your name

Your email

Submission Tiie

Upload your minutes Choose File Mo file chosen

Submit

12.  What is the submission index?

A full list of proposals is available using the “Submission Index” report found on the top tool
bar.

11
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Any of the content of the columns displayed in this report are searchable and sortable,
additional pages with more results are located at the bottom of the screen.

IDEAS-LAB HOME CONSTITUTION SUBMISSION INDEX FR  LOG OU

Submission Index

@ PRINT " EXPORT

Q SEARCH TABLE

ENTRIES

D

A ROLE OF

21/0712025
286
GOVERNMENT

12:26 PM

13. How do | co-sponsor a submission?

For the proposal phase, each EDA may submit/sponsor or co-sponsor up to 5 items on Ideas
Lab for Policy, and up to 10 submissions and 10 co-sponsorships for Constitution.

To co-sponsor a submission:

a. Cosponsors must first be approved by a motion of your EDA board (not just the
executive or any sub-committee).

b. You then click into the submission and click on the button that says “Co-Sponsor”:

‘ ID:

Title: - test

Contact: Rory McTory

rorymetory@conservative.ca

‘ Sponsoring Riding: 35079 - Ottawa Centre
Co-Sponsoring ridings:

Co-Sponsor:

Co-Sponsor

Your EDA has 5 submissions remaining

c. You will then be taken to the page to submit board meeting minutes approving
this cosponsorship.

d. Cosponsorships cannot be changed, unless they are cast in error. If they are cast in
error, please email Oversightcommittee@conservative.ca or your local NPC/NCC

representative with the explanation and request to remove cosponsorships cast in
error.

12
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14. What will the oversight committee be looking for?

The Oversight Committee (“OC”) is responsible to ensure that EDA’s sponsoring and
cosponsoring Submissions have satisfied the requirements put in place. This task will be
completed prior to any submission being deemed eligible to advance to the voting phase, or
to Convention.

The OC will work with Sponsoring EDA’s to correct deficiencies and missing elements.
Submissions that fail to meet the requirements whether through deliberate action or
inaction may be disqualified from further advancement.

The following are a few examples of required elements and matters that may be considered
by the OC:

Exceeding Word Count Limit

Fail to include or achieve required co-sponsors

Fail to prove EDA Board support via minutes

Submission is NOT a Policy matter (ie: Constitutional) and vice versa.
Policy Submission does not fall under the scope of Federal Jurisdiction

AN NI NI NN

15. Can | delete, edit or change my submission?

Yes, you can delete, edit or change your submission at any time before the submission
deadline. However, any major changes or deletions must be approved by your EDA board
and new relevant minutes must be submitted.

If you click on your post, on the top left there are three options for editing the submissions:

Retumn to Submissions

Edit Post

Delete Submission

16. What is the “Time Counter”?
The countdown timer shows the countdown to the next deadline, which is 11:59 PM Eastern

Time. The countdown time will be updated to the next deadline (for example Voting
Deadline) on Ideas lab after the current deadline passes.

13



Last day for Regional Meetings / Submission
Deadline

114 01 16 13

DEVE Hours Minutes  Seconds

17.  How do | know whether an EDA has submitted proposals or votes?

Clicking on an EDA link anywhere shown in Ideas Lab, such as those in the proposal screen or
from the user index, will provide a detailed EDA activity log showcasing its consolidated
number of Policy and Constitution proposals submitted or co-sponsored, votes cast, and
contact information. This summary of the activity of your EDA on Ideas Lab is fully visible to
all Ideas Lab registered users. The link to the EDA activity log page can be shared with other
public users, but the contact information is not shared publicly.

This page also includes a “Bio” field which you can use to provide background about the EDA
and its leadership, as well as information on how to contact the EDA’s Constitution and/or
Policy chair(s). Only EDA president accounts can submit proposals, cast cosponsorships or
vote:

ONTARIO: 10000 - CPC HQ

Contact Empowered By EDA:

Narme: Rty McTary
EDAA President

ronymoioryBonnssrvative ca

Puilicy Prioies:

Actions Taken Per EDA Board Resolution:

Constitution

Proposing Phasze
First Submizslon Date Last Submisslon Date

Spansared:

14



Use this report to keep tabs of the total # of sponsorships/co-sponsorships and votes
expended by your EDA. EDA’s can also use it to see how much of their allocations other EDAs
have already expended and whether they have co-sponsorship or voting room to spare for
other Ideas Lab submissions.

18. How and when can we vote on a submission?
The 21 Day Voting Period opens on November 20, 2025 and ends on December 11, 2025.

The VOTE Button will become visible at the bottom of each individual constitution or policy
submission on or about November 20, 2025.

We support this proposal

Total Votes Alowed
Total Votes Cast by your Riding

Voles Remaining

Each EDA may Vote in Favor of up to 20 Policy Submissions and up to 25 Constitution
Amendments.

Your riding has already voted for this submission. If this was done in error, please contact your regional rep to have it removed.

Total Voles Alowed 20

Total Votes Cast by your Riding

Voles Remaining
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